Contents

About this manual .............................................................................................. 1
Safety information .............................................................................................. 2
Chapter 1 Basics and Assembly ..................................................................... 1-1
  Safety Information for Users ...................................................................... 1-2
  System conception ....................................................................................... 1-3
  Dimensions ................................................................................................. 1-5
  Installation ................................................................................................. 1-7
  Demounting and module exchange ......................................................... 1-11
  Wiring ........................................................................................................ 1-12
  Installation guidelines ............................................................................. 1-14
  General data .............................................................................................. 1-17
Chapter 2 Hardware description .................................................................... 2-1
  Properties ................................................................................................. 2-2
  Structure ................................................................................................. 2-3
  Technical data .......................................................................................... 2-7
Chapter 3 Deployment CPU 21x-2BM03 .................................................... 3-1
  Assembly ................................................................................................. 3-2
  Start-up behavior ...................................................................................... 3-2
  Addressing ............................................................................................... 3-3
  Hints for the deployment of the MPI interface ........................................ 3-5
  Hardware configuration - CPU ............................................................... 3-6
  Hardware configuration - I/O modules .................................................... 3-8
  Setting CPU parameters ......................................................................... 3-9
  Project transfer ....................................................................................... 3-13
  Operating modes .................................................................................... 3-17
  Overall reset .......................................................................................... 3-19
  Firmware update .................................................................................... 3-21
  Factory reset .......................................................................................... 3-23
  VIPA specific diagnostic entries ............................................................. 3-24
  Using test functions for control and monitoring of variables ................ 3-26
Chapter 4 PROFIBUS communication ....................................................... 4-1
  Overview ................................................................................................. 4-2
  Project engineering CPU with integrated PROFIBUS DP master ......... 4-5
  PROFIBUS installation guidelines ........................................................... 4-7
  Commissioning and Start-up behavior ................................................... 4-10
About this manual

This manual describes the System 200V CPU 21x-2BM03 from VIPA. Here you may find every information for commissioning and operation.

Overview

Chapter 1: Basics and Assembly
The focus of this chapter is on the introduction of the VIPA System 200V. Here you will find the information required to assemble and wire a controller system consisting of System 200V components. Besides the dimensions the general technical data of System 200V will be found.

Chapter 2: Hardware description
Here the hardware components of the CPU are described. The technical data are at the end of the chapter.

Chapter 3: Deployment CPU 21x-2BM03
This chapter describes the deployment of the CPU in the System 200V. The description refers directly to the CPU and to the deployment in connection with peripheral modules, mounted on a profile rail together with the CPU at the backplane bus.

Chapter 4: PROFIBUS communication
Content of this chapter is the deployment of the 21x-2BM03 with PROFIBUS. After a short introduction into the PROFIBUS system, the project engineering and the usage with PROFIBUS is shown. This chapter ends with information about commissioning and start-up behavior of the DP master.
This manual describes the System 200V CPU 21x-2BM03 from VIPA. It contains a description of the construction, project implementation and usage.

This manual is part of the documentation package with order number HB97E_CPU and relevant for:

<table>
<thead>
<tr>
<th>Product</th>
<th>Order number</th>
<th>as of state:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 21xDPM</td>
<td>VIPA CPU 21x-2BM03</td>
<td>01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CPU-HW: V 4.1.7</td>
</tr>
</tbody>
</table>

The manual is targeted at users who have a background in automation technology.

The manual consists of chapters. Every chapter provides a self-contained description of a specific topic.

The following guides are available in the manual:
- an overall table of contents at the beginning of the manual
- an overview of the topics for every chapter

The manual is available in:
- printed form, on paper
- in electronic form as PDF-file (Adobe Acrobat Reader)

Important passages in the text are highlighted by following icons and headings:

**Danger!**
Immediate or likely danger.
Personal injury is possible.

**Attention!**
Damages to property is likely if these warnings are not heeded.

**Note!**
Supplementary information and useful tips.
Safety information

Applications conforming with specifications

The CPU 21x is constructed and produced for:

- all VIPA System 200V components
- communication and process control
- general control and automation applications
- industrial applications
- operation within the environmental conditions specified in the technical data
- installation into a cubicle

Danger!

This device is not certified for applications in

- in explosive environments (EX-zone)

Documentation

The manual must be available to all personnel in the

- project design department
- installation department
- commissioning
- operation

The following conditions must be met before using or commissioning the components described in this manual:

- Hardware modifications to the process control system should only be carried out when the system has been disconnected from power!

- Installation and hardware modifications only by properly trained personnel.

- The national rules and regulations of the respective country must be satisfied (installation, safety, EMC ...)

Disposal

National rules and regulations apply to the disposal of the unit!
Chapter 1  Basics and Assembly

Overview
The focus of this chapter is on the introduction of the VIPA System 200V. Here you will find the information required to assemble and wire a controller system consisting of System 200V components. Besides the dimensions the general technical data of System 200V will be found.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1 Basics and Assembly</td>
<td>1-1</td>
</tr>
<tr>
<td>Safety Information for Users</td>
<td>1-2</td>
</tr>
<tr>
<td>System conception</td>
<td>1-3</td>
</tr>
<tr>
<td>Dimensions</td>
<td>1-5</td>
</tr>
<tr>
<td>Installation</td>
<td>1-7</td>
</tr>
<tr>
<td>Demounting and module exchange</td>
<td>1-11</td>
</tr>
<tr>
<td>Wiring</td>
<td>1-12</td>
</tr>
<tr>
<td>Installation guidelines</td>
<td>1-14</td>
</tr>
<tr>
<td>General data</td>
<td>1-17</td>
</tr>
</tbody>
</table>
Safety Information for Users

VIPA modules make use of highly integrated components in MOS-Technology. These components are extremely sensitive to over-voltages that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by electrostatic discharges.

![Symbol]

The Symbol is located on the module, the module rack or on packing material and it indicates the presence of electrostatic sensitive equipment.

It is possible that electrostatic sensitive equipment is destroyed by energies and voltages that are far less than the human threshold of perception. These voltages can occur where persons do not discharge themselves before handling electrostatic sensitive modules and they can damage components thereby, causing the module to become inoperable or unusable.

Modules that have been damaged by electrostatic discharges can fail after a temperature change, mechanical shock or changes in the electrical load. Only the consequent implementation of protection devices and meticulous attention to the applicable rules and regulations for handling the respective equipment can prevent failures of electrostatic sensitive modules.

Modules must be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive modules you should take the following precautions:

- Floating instruments must be discharged before use.
- Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering irons with grounded tips.

Attention!
Personnel and instruments should be grounded when working on electrostatic sensitive modules.
System conception

Overview
The System 200V is a modular automation system for assembly on a 35mm profile rail. By means of the peripheral modules with 4, 8 and 16 channels this system may properly be adapted matching to your automation tasks.

Components
The System 200V consists of the following components:
- **Head modules** like CPU and bus coupler
- **Periphery modules** like I/O, function und communication modules
- **Power supplies**
- **Extension modules**

Head modules
With a head module CPU respectively bus interface and DC 24V power supply are integrated to one casing.
Via the integrated power supply the CPU respectively bus interface is power supplied as well as the electronic of the connected periphery modules.

Periphery modules
The modules are direct installed on a 35mm profile rail and connected to the head module by a bus connector, which was mounted on the profile rail before.
Most of the periphery modules are equipped with a 10pin respectively 18pin connector. This connector provides the electrical interface for the signaling and supplies lines of the modules.
Power supplies

With the System 200V the DC 24V power supply can take place either externally or via a particularly for this developed power supply. The power supply may be mounted on the profile rail together with the System 200V modules. It has no connector to the backplane bus.

Expansion modules

The expansion modules are complementary modules providing 2- or 3-wire connection facilities. The modules are not connected to the backplane bus.

Structure/dimensions

- Profile rail 35mm
- Dimensions of the basic enclosure:
  1-tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3
  2-tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3

Installation

Please note that you can only install header modules, like the CPU, the PC and couplers at slot 1 or 1 and 2 (for double width modules).

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Head module (double width)</td>
</tr>
<tr>
<td>2</td>
<td>Head module (single width)</td>
</tr>
<tr>
<td>3</td>
<td>Periphery module</td>
</tr>
<tr>
<td>4</td>
<td>Guide rails</td>
</tr>
</tbody>
</table>

Note

A maximum of 32 modules can be connected at the backplane bus. Take attention that here the maximum sum current of 3.5A is not exceeded. Please install modules with a high current consumption directly beside the header module.
Dimensions

**Basic enclosure**
- 1-tier width (HxWxD) in mm: 76 x 25.4 x 74
- 2-tier width (HxWxD) in mm: 76 x 50.8 x 74

**Installation dimensions**

**Installed and wired dimensions**

In-/ Output modules
Function modules/
Extension modules

CPUs (here with
EasyConn from
VIPA)
Installation

General
The modules are each installed on a 35mm profile rail and connected via a bus connector. Before installing the module, the bus connector is to be placed on the profile rail before.

Profile rail
For installation, the following 35mm profile rails may be used:

<table>
<thead>
<tr>
<th>Order number</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>290-1AF00</td>
<td>35mm profile rail</td>
<td>Length 2000mm, height 15mm</td>
</tr>
<tr>
<td>290-1AF30</td>
<td>35mm profile rail</td>
<td>Length 530mm, height 15mm</td>
</tr>
</tbody>
</table>

Bus connector
System 200V modules communicate via a backplane bus connector. The backplane bus connector is isolated and available from VIPA in 1-, 2-, 4- or 8-tier width.

The following figure shows a 1-tier connector and a 4-tier connector bus:

The bus connector is to be placed on the profile rail until it clips in its place and the bus connections look out from the profile rail.

<table>
<thead>
<tr>
<th>Order number</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>290-0AA10</td>
<td>Bus connector</td>
<td>1-tier</td>
</tr>
<tr>
<td>290-0AA20</td>
<td>Bus connector</td>
<td>2-tier</td>
</tr>
<tr>
<td>290-0AA40</td>
<td>Bus connector</td>
<td>4-tier</td>
</tr>
<tr>
<td>290-0AA80</td>
<td>Bus connector</td>
<td>8-tier</td>
</tr>
</tbody>
</table>
Installation on a profile rail

The following figure shows the installation of a 4-tier width bus connector in a profile rail and the slots for the modules. The different slots are defined by guide rails.

1. Header module (double width)
2. Header module (single width)
3. Peripheral module
4. Guide rails

Assembly regarding the current consumption

- Use bus connectors as long as possible.
- Sort the modules with a high current consumption right beside the header module. In the service area of www.vipa.com a list of current consumption of every System 200V module can be found.
Please regard the allowed environmental temperatures:

- horizontal assembly: from 0 to 60°C
- vertical assembly: from 0 to 40°C
- lying assembly: from 0 to 40°C

The horizontal assembly always starts at the left side with a header module, then you install the peripheral modules beside to the right. You may install up to 32 peripheral modules.

Please follow these rules during the assembly!

- Turn off the power supply before you install or remove any modules!
- Make sure that a clearance of at least 60mm exists above and 80mm below the middle of the profile rail.

- Every row must be completed from left to right and it has to start with a header module.

[1] Header module (double width)
[2] Header module (single width)
[3] Peripheral modules

- Modules are to be installed side by side. Gaps are not permitted between the modules since this would interrupt the backplane bus.
- A module is only installed properly and connected electrically when it has clicked into place with an audible click.
- Slots after the last module may remain unoccupied.

Note!
A maximum of 32 modules can be connected at the back plane bus. Take attention that here the maximum sum current of 3.5A is not exceeded.
Assembly procedure

- Install the profile rail. Make sure that a clearance of at least 60mm exists above and 80mm below the middle of the profile rail.

- Press the bus connector into the profile rail until it clips securely into place and the bus-connectors look out from the profile rail. This provides the basis for the installation of your modules.

- Start at the outer left location with the installation of your header module and install the peripheral modules to the right of this.

- Insert the module that you are installing into the profile rail at an angle of 45 degrees from the top and rotate the module into place until it clicks into the profile rail with an audible click. The proper connection to the backplane bus can only be guaranteed when the module has properly clicked into place.

Attention!
Power must be turned off before modules are installed or removed!
Demounting and module exchange

1. Remove if exists the wiring to the module, by pressing both locking lever on the connector and pulling the connector.

2. The casing of the module has a spring loaded clip at the bottom by which the module can be removed.

3. The clip is unlocked by pressing the screwdriver in an upward direction.

4. Withdraw the module with a slight rotation to the top.

5. **Attention!**
   
   Power must be turned off before modules are installed or removed!
   
   Please regard that the backplane bus is interrupted at the point where the module was removed!
Wiring

Overview

Most peripheral modules are equipped with a 10pole or a 18pole connector. This connector provides the electrical interface for the signaling and supply lines of the modules.

The modules carry spring-clip connectors for interconnections and wiring. The spring-clip connector technology simplifies the wiring requirements for signaling and power cables.

In contrast to screw terminal connections, spring-clip wiring is vibration proof. The assignment of the terminals is contained in the description of the respective modules.

You may connect conductors with a diameter from 0.08mm² up to 2.5mm² (max. 1.5mm² for 18pole connectors).

The following figure shows a module with a 10pole connector.

![Diagram of a module with a 10pole connector]

[1] Locking lever
[2] Pin no. at the module
[3] Pin no. at the connector
[5] Opening for screwdriver

Note!

The spring-clip is destroyed if you push the screwdriver into the wire port! Make sure that you only insert the screwdriver into the square hole of the connector!
Wiring procedure

- Install the connector on the module until it locks with an audible click. For this purpose you press the two clips together as shown. The connector is now in a permanent position and can easily be wired.

The following section shows the wiring procedure from top view.

- Insert a screwdriver at an angle into the square opening as shown.
- Press and hold the screwdriver in the opposite direction to open the contact spring.

- Insert the stripped end of the wire into the round opening. You can use wires with a diameter of 0.08mm² to 2.5mm² (1.5mm² for 18-pole connectors).

- By removing the screwdriver the wire is connected safely with the plug connector via a spring.

Note!
Wire the power supply connections first followed by the signal cables (inputs and outputs).
Installation guidelines

General
The installation guidelines contain information about the interference free deployment of System 200V systems. There is the description of the ways, interference may occur in your control, how you can make sure the electromagnetic digestibility (EMC), and how you manage the isolation.

What means EMC?
Electromagnetic digestibility (EMC) means the ability of an electrical device, to function error free in an electromagnetic environment without being interferenced res. without interfering the environment.
All System 200V components are developed for the deployment in hard industrial environments and fulfill high demands on the EMC. Nevertheless you should project an EMC planning before installing the components and take conceivable interference causes into account.

Possible interference causes
Electromagnetic interferences may interfere your control via different ways:
- Electromagnetic fields (RF coupling)
- Magnetic fields with power frequency
- I/O signal conductors
- Bus system
- Current supply
- Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the distance to the interference cause, interferences to your control occur by means of different coupling mechanisms.
One differs:
- galvanic coupling
- capacitive coupling
- inductive coupling
- radiant coupling
In the most times it is enough to take care of some elementary rules to guarantee the EMC. Please regard the following basic rules when installing your PLC.

- Take care of a correct area-wide grounding of the inactive metal parts when installing your components.
  - Install a central connection between the ground and the protected earth conductor system.
  - Connect all inactive metal extensive and impedance-low.
  - Please try not to use aluminum parts. Aluminum is easily oxidizing and is therefore less suitable for grounding.

- When cabling, take care of the correct line routing.
  - Organize your cabling in line groups (high voltage, current supply, signal and data lines).
  - Always lay your high voltage lines and signal res. data lines in separate channels or bundles.
  - Route the signal and data lines as near as possible beside ground areas (e.g. suspension bars, metal rails, tin cabinet).

- Proof the correct fixing of the lead isolation.
  - Data lines must be laid isolated (for details see below).
  - Analog lines must be laid isolated. When transmitting signals with small amplitudes the one sided laying of the isolation may be favorable.
  - Lay the line isolation extensively on an isolation/protected earth conductor rail directly after the cabinet entry and fix the isolation with cable clamps.
  - Make sure that the isolation/protected earth conductor rail is connected impedance-low with the cabinet.
  - Use metallic or metalized plug cases for isolated data lines.

- In special use cases you should appoint special EMC actions.
  - Wire all inductivities with erase links, which are not addressed by the System SLIO modules.
  - For lightening cabinets you should avoid luminescent lamps.

- Create a homogeneous reference potential and ground all electrical operating supplies when possible.
  - Please take care for the targeted employment of the grounding actions. The grounding of the PLC is a protection and functionality activity.
  - Connect installation parts and cabinets with the System SLIO in star topology with the isolation/protected earth conductor system. So you avoid ground loops.
  - If potential differences between installation parts and cabinets occur, lay sufficiently dimensioned potential compensation lines.
Isolation of conductors

Electrical, magnetically and electromagnetic interference fields are weakened by means of an isolation, one talks of absorption. Via the isolation rail, that is connected conductive with the rack, interference currents are shunt via cable isolation to the ground. Hereby you have to make sure, that the connection to the protected earth conductor is impedance-low, because otherwise the interference currents may appear as interference cause.

When isolating cables you have to regard the following:

- If possible, use only cables with isolation tangle.
- The hiding power of the isolation should be higher than 80%.
- Normally you should always lay the isolation of cables on both sides. Only by means of the both-sided connection of the isolation you achieve high quality interference suppression in the higher frequency area. Only as exception you may also lay the isolation one-sided. Then you only achieve the absorption of the lower frequencies. A one-sided isolation connection may be convenient, if:
  - the conduction of a potential compensating line is not possible
  - analog signals (some mV res. µA) are transferred
  - foil isolations (static isolations) are used.
- With data lines always use metallic or metalized plugs for serial couplings. Fix the isolation of the data line at the plug rack. Do not lay the isolation on the PIN 1 of the plug bar!
- At stationary operation it is convenient to strip the insulated cable interruption free and lay it on the isolation/protected earth conductor line.
- To fix the isolation tangles use cable clamps out of metal. The clamps must clasp the isolation extensively and have well contact.
- Lay the isolation on an isolation rail directly after the entry of the cable in the cabinet. Lead the isolation further on to the System 200V module and don't lay it on there again!

Please regard at installation!

At potential differences between the grounding points, there may be a compensation current via the isolation connected at both sides. Remedy: Potential compensation line.
General data

Structure/ dimensions

- Profile rail 35mm
- Peripheral modules with recessed labelling
- Dimensions of the basic enclosure:
  1 tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3
  2 tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3

Reliability

- Wiring by means of spring pressure connections (CageClamps) at the front-facing connector, core cross-section 0.08 ... 2.5mm² or 1.5mm² (18pole plug)
- Complete isolation of the wiring when modules are exchanged
- Every module is isolated from the backplane bus
### General data

<table>
<thead>
<tr>
<th>Conformity and approval</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conformity</strong></td>
</tr>
<tr>
<td>CE</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Approval</strong></td>
</tr>
<tr>
<td>UL</td>
</tr>
<tr>
<td><strong>RoHS</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Protection of persons and device protection</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of protection</strong></td>
</tr>
<tr>
<td><strong>Electrical isolation</strong></td>
</tr>
<tr>
<td>to the field bus</td>
</tr>
<tr>
<td>to the process level</td>
</tr>
<tr>
<td><strong>Insulation resistance</strong></td>
</tr>
<tr>
<td><strong>Insulation voltage to reference earth</strong></td>
</tr>
<tr>
<td><strong>Protective measures</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Environmental conditions to EN 61131-2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Climatic</strong></td>
</tr>
<tr>
<td><strong>Storage / transport</strong></td>
</tr>
<tr>
<td><strong>Operation</strong></td>
</tr>
<tr>
<td>Horizontal installation</td>
</tr>
<tr>
<td>Vertical installation</td>
</tr>
<tr>
<td><strong>Air humidity</strong></td>
</tr>
<tr>
<td><strong>Pollution</strong></td>
</tr>
<tr>
<td><strong>Mechanical</strong></td>
</tr>
<tr>
<td>Oscillation</td>
</tr>
<tr>
<td>Shock</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mounting conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mounting place</strong></td>
</tr>
<tr>
<td><strong>Mounting position</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EMC</th>
<th>Standard</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emitted interference</strong></td>
<td>EN 61000-6-4</td>
<td>Class A (Industrial area)</td>
</tr>
<tr>
<td>Noise immunity zone B</td>
<td>EN 61000-6-2</td>
<td>Industrial area</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-2</td>
<td>ESD 8kV at air discharge (degree of severity 3), 4kV at contact discharge (degree of severity 2)</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-3</td>
<td>HF field immunity (casing) 80MHz ... 1000MHz, 10V/m, 80% AM (1kHz) 1.4GHz ... 2.0GHz, 3V/m, 80% AM (1kHz) 2GHz ... 2.7GHz, 1V/m, 80% AM (1kHz)</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-6</td>
<td>HF conducted 150kHz ... 80MHz, 10V, 80% AM (1kHz)</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-4</td>
<td>Burst, degree of severity 3</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-5</td>
<td>Surge, installation class 3 *)</td>
</tr>
</tbody>
</table>

*) Due to the high-energetic single pulses with Surge an appropriate external protective circuit with lightning protection elements like conductors for lightning and overvoltage is necessary.
Chapter 2  Hardware description

Overview

Here the hardware components of the CPU are described. The technical data are at the end of the chapter.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2 Hardware description</td>
<td>2-1</td>
</tr>
<tr>
<td>Properties</td>
<td>2-2</td>
</tr>
<tr>
<td>Structure</td>
<td>2-3</td>
</tr>
<tr>
<td>Technical data</td>
<td>2-7</td>
</tr>
</tbody>
</table>
Properties

CPU 21x-2BM03

- Instruction set compatible with Siemens STEP7
- Configuration by means of the Siemens SIMATIC manager
- Integrated V-Bus controller for controlling System 200V peripherals
- Integrated 24V power supply
- Total address range: 1024Byte inputs, 1024Byte outputs (128Byte process image each)
- 96 / 128kByte of work memory "on board"
- 144 / 192kByte of load memory "on board"
- MMC slot (for user program)
- Battery backed clock
- MP²I interface for data transfer
- Status LEDs for operating mode and diagnostics
- Integrated PROFIBUS DP master

Order data

<table>
<thead>
<tr>
<th>Type</th>
<th>Order number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 214DPM</td>
<td>VIPA 214-2BM03</td>
<td>SPS CPU 214 with PROFIBUS master and 96/144kByte of work/load memory</td>
</tr>
<tr>
<td>CPU 215DPM</td>
<td>VIPA 215-2BM03</td>
<td>SPS CPU 214 with PROFIBUS master and 128/192kByte of work/load memory</td>
</tr>
</tbody>
</table>
Structure

Front view
CPU 21xDPM

[1] Operating mode switch
[2] LEDs of the CPU
[3] Slot for MMC memory card
[4] MP²I interface
[5] Slot for 24V DC power supply
[6] LEDs of the PROFIBUS DP master
[7] PROFIBUS DP interface

Interfaces

DP master

1. shield
2. reserved
3. Rx/Dx/Tx-D-P (line B)
4. RTS
5. M5V
6. P5V
7. n. c.
8. Rx/Dx/Tx-D-N (line A)
9. n.c.

MP²I

1. reserved
2. M24V
3. Rx/Dx/Tx-D-P (line B)
4. RTS
5. M5V
6. P5V
7. P24V
8. Rx/Dx/Tx-D-N (line A)
9. n.c.

Please note that due to the system pin 2 of the PROFIBUS interface must not be connected!
Chapter 2  Hardware description

Power supply

The CPU has an internal power supply. This is connected to an external supply voltage via two terminals located on the front of the unit.

The power supply requires DC 24V (20.4 ... 28.8V). In addition to the electronic circuitry of the CPU this supply voltage is used for the modules connected to the backplane bus.

The electronic circuitry of the CPU is not dc-insulated from the supply voltage. The power supply is protected against reverse polarity and short circuits.

Note!

Please ensure that the polarity of the supply voltage is correct.

MP³I interface

The MPI unit provides the link for the data transfer between the CPU and the PC. Via bus communication you are able to exchange programs and data between different CPUs that are linked over MPI.

For a serial exchange between the partners you normally need a special MPI-converter. But now you are also able to use the VIPA “Green Cable” (Order-No. VIPA 950-0KB00), which allows you to establish a serial peer-to-peer connection over the MPI interface.

Please regard the "Hints for the deployment of the MPI interface" in chapter "Deployment CPU 21x".

PROFIBUS interface

The CPU is connected to the PROFIBUS system by means of a 9pin jack.

Note!

More information about PROFIBUS can be found in the chapter "PROFIBUS communication".
The CPUs have an integrated work and a load memory. The memories are battery-buffered.

<table>
<thead>
<tr>
<th>Order number</th>
<th>Work memory</th>
<th>Load memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIPA 214-2BM03</td>
<td>96kByte</td>
<td>144kByte</td>
</tr>
<tr>
<td>VIPA 215-2BM03</td>
<td>128kByte</td>
<td>192kByte</td>
</tr>
</tbody>
</table>

In the load memory there are program code and blocks stored together with the header information. The program parts and blocks, which are relevant for the running program, are loaded to the work memory during the program sequence.

With the operating mode switch you may switch the CPU between STOP and RUN. During the transition from STOP to RUN the operating mode START-UP is driven by the CPU. By Switching to MR (Memory Reset) you request an overall reset with following load from MMC, if a project there exists.

You may install a VIPA MMC memory card in this slot as external storage device (Order No.: VIPA 953-0KX10). The access to the MMC takes always place after an overall reset.

A rechargeable battery is installed on every CPU 21x to safeguard the contents of the RAM when power is removed. This battery is also used to buffer the internal clock. The rechargeable battery is maintained by a charging circuit that receives its power from the internal power supply and that maintain the clock and RAM for a max. period of 30 days.

Due to a long storage of the CPU, the battery may be discharged excessively. Please connect the CPU at least for 24 hours to the power supply, to achieve the full buffer capacity. After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset, because with an empty battery the RAM content is undefined.
### LEDS CPU

The CPU has got LEDs on its front side. In the following the usage and the according colors of the LEDs is described.

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PW</td>
<td>green</td>
<td>Indicates CPU power on.</td>
</tr>
<tr>
<td>R</td>
<td>green</td>
<td>CPU status is RUN.</td>
</tr>
<tr>
<td>S</td>
<td>yellow</td>
<td>CPU status is STOP.</td>
</tr>
<tr>
<td>SF</td>
<td>red</td>
<td>Is turned on if a system error is detected (hardware defect)</td>
</tr>
<tr>
<td>FC</td>
<td>yellow</td>
<td>Is turned on when variables are forced (fixed).</td>
</tr>
<tr>
<td>MC</td>
<td>yellow</td>
<td>This LED blinks when the MMC is accessed.</td>
</tr>
</tbody>
</table>

### LEDS PROFIBUS DP master

The LEDs are located in the left half of the front panel and they are used for diagnostic purposes. The following table shows the color and the significance of these LEDs.

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RN</td>
<td>green</td>
<td>DP-Master-RUN&lt;br&gt;On: Master status is RUN. The slaves are being accessed and the outputs are 0 (&quot;clear&quot; state).&lt;br&gt;On with DE: Master status is &quot;operate&quot;. and is communicating with the slaves.</td>
</tr>
<tr>
<td>IF</td>
<td>red</td>
<td>Initialization error&lt;br&gt;On: Error in PROFIBUS configuration</td>
</tr>
<tr>
<td>DE</td>
<td>yellow</td>
<td>DE (Data exchange)&lt;br&gt;On: Indicates PROFIBUS communication activity.</td>
</tr>
<tr>
<td>ER</td>
<td>red</td>
<td>Error&lt;br&gt;On: Slave has failed</td>
</tr>
</tbody>
</table>
## Technical data

### 214-2BM03

<table>
<thead>
<tr>
<th>Order no.</th>
<th>214-2BM03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 214DPM</td>
</tr>
<tr>
<td><strong>Technical data power supply</strong></td>
<td></td>
</tr>
<tr>
<td>Power supply (rated value)</td>
<td>DC 24 V</td>
</tr>
<tr>
<td>Power supply (permitted range)</td>
<td>DC 20.4...28.8 V</td>
</tr>
<tr>
<td>Reverse polarity protection</td>
<td>✓</td>
</tr>
<tr>
<td>Current consumption (no-load operation)</td>
<td>130 mA</td>
</tr>
<tr>
<td>Current consumption (rated value)</td>
<td>1.5 A</td>
</tr>
<tr>
<td>Inrush current</td>
<td>65 A</td>
</tr>
<tr>
<td>$I^2t$</td>
<td>0.75 A²s</td>
</tr>
<tr>
<td>Max. current drain at backplane bus</td>
<td>3 A</td>
</tr>
<tr>
<td>Power loss</td>
<td>5 W</td>
</tr>
<tr>
<td><strong>Load and working memory</strong></td>
<td></td>
</tr>
<tr>
<td>Load memory, integrated</td>
<td>144 KB</td>
</tr>
<tr>
<td>Load memory, maximum</td>
<td>144 KB</td>
</tr>
<tr>
<td>Work memory, integrated</td>
<td>96 KB</td>
</tr>
<tr>
<td>Work memory, maximal</td>
<td>96 KB</td>
</tr>
<tr>
<td>Memory divided in 50% program / 50% data</td>
<td>-</td>
</tr>
<tr>
<td>Memory card slot</td>
<td>MMC-Card with max. 512 MB</td>
</tr>
<tr>
<td><strong>Hardware configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Racks, max.</td>
<td>4</td>
</tr>
<tr>
<td>Modules per rack, max.</td>
<td>total max. 32</td>
</tr>
<tr>
<td>Number of integrated DP master</td>
<td>1</td>
</tr>
<tr>
<td>Number of DP master via CP</td>
<td>8</td>
</tr>
<tr>
<td>Operable function modules</td>
<td>32</td>
</tr>
<tr>
<td>Operable communication modules PtP</td>
<td>32</td>
</tr>
<tr>
<td>Operable communication modules LAN</td>
<td>-</td>
</tr>
<tr>
<td><strong>Command processing times</strong></td>
<td></td>
</tr>
<tr>
<td>Bit instructions, min.</td>
<td>0.18 µs</td>
</tr>
<tr>
<td>Word instruction, min.</td>
<td>0.78 µs</td>
</tr>
<tr>
<td>Double integer arithmetic, min.</td>
<td>1.8 µs</td>
</tr>
<tr>
<td>Floating-point arithmetic, min.</td>
<td>40 µs</td>
</tr>
<tr>
<td><strong>Timers/Counters and their retentive characteristics</strong></td>
<td></td>
</tr>
<tr>
<td>Number of S7 counters</td>
<td>256</td>
</tr>
<tr>
<td>S7 counter remanence adjustable</td>
<td>0 up to 64</td>
</tr>
<tr>
<td>S7 counter remanence adjustable C0 .. C7</td>
<td>-</td>
</tr>
<tr>
<td>Number of S7 times</td>
<td>256</td>
</tr>
<tr>
<td>S7 times remanence adjustable</td>
<td>0 up to 128</td>
</tr>
<tr>
<td>S7 times remanence not retentive</td>
<td>-</td>
</tr>
<tr>
<td><strong>Data range and retentive characteristic</strong></td>
<td></td>
</tr>
<tr>
<td>Number of flags</td>
<td>8192 Bit</td>
</tr>
<tr>
<td>Bit memories retentive characteristic adjustable</td>
<td>adjustable 0 up to 256</td>
</tr>
<tr>
<td>Bit memories retentive characteristic preset MB0 .. MB15</td>
<td>-</td>
</tr>
<tr>
<td>Number of data blocks</td>
<td>2047</td>
</tr>
<tr>
<td>Max. data blocks size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range DBs</td>
<td>1 ... 2047</td>
</tr>
<tr>
<td>Max. local data size per execution level</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Max. local data size per block</td>
<td>1024 Byte</td>
</tr>
<tr>
<td><strong>Blocks</strong></td>
<td></td>
</tr>
<tr>
<td>Number of OBs</td>
<td>14</td>
</tr>
<tr>
<td>Maximum OB size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Total number DBs, FBs, FCs</td>
<td>-</td>
</tr>
<tr>
<td>Number of FBs</td>
<td>1024</td>
</tr>
<tr>
<td>Maximum FB size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range FBs</td>
<td>0 ... 1023</td>
</tr>
</tbody>
</table>
## Chapter 2  Hardware description

**Manual VIPA System 200V**

<table>
<thead>
<tr>
<th>Order no.</th>
<th>214-2BM03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of FCs</td>
<td>1024</td>
</tr>
<tr>
<td>Maximum FC size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range FCs</td>
<td>0 ... 1023</td>
</tr>
<tr>
<td>Maximum nesting depth per priority class</td>
<td>8</td>
</tr>
<tr>
<td>Maximum nesting depth additional within an error OB</td>
<td>1</td>
</tr>
</tbody>
</table>

### Time

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time clock buffered</td>
<td>✓</td>
</tr>
<tr>
<td>Clock buffered period (min.)</td>
<td>30 d</td>
</tr>
<tr>
<td>Type of buffering</td>
<td>Vanadium Rechargeable Lithium Batterie</td>
</tr>
<tr>
<td>Load time for 50% buffering period</td>
<td>20 h</td>
</tr>
<tr>
<td>Load time for 100% buffering period</td>
<td>48 h</td>
</tr>
<tr>
<td>Accuracy (max. deviation per day)</td>
<td>10 s</td>
</tr>
<tr>
<td>Number of operating hours counter</td>
<td>8</td>
</tr>
<tr>
<td>Clock synchronization</td>
<td>-</td>
</tr>
<tr>
<td>Synchronization via MPI</td>
<td>-</td>
</tr>
<tr>
<td>Synchronization via Ethernet (NTP)</td>
<td>-</td>
</tr>
</tbody>
</table>

### Address areas (I/O)

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input I/O address area</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Output I/O address area</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Process image adjustable</td>
<td>-</td>
</tr>
<tr>
<td>Input process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Output process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Input process image maximal</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Output process image maximal</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8192</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8192</td>
</tr>
<tr>
<td>Digital inputs central</td>
<td>512</td>
</tr>
<tr>
<td>Digital outputs central</td>
<td>512</td>
</tr>
<tr>
<td>Integrated digital inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated digital outputs</td>
<td>-</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog inputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Analog outputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Integrated analog inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated analog outputs</td>
<td>-</td>
</tr>
</tbody>
</table>

### Communication functions

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>Number of GD circuits, max.</td>
<td>4</td>
</tr>
<tr>
<td>Size of GD packets, max.</td>
<td>22 Byte</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication, user data per job</td>
<td>76 Byte</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication, user data per job</td>
<td>160 Byte</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>16</td>
</tr>
</tbody>
</table>

### Functionality Sub-D interfaces

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>MPI</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>-</td>
</tr>
<tr>
<td>MPI</td>
<td>✓</td>
</tr>
<tr>
<td>MPI (MPI/RS232)</td>
<td>✓</td>
</tr>
<tr>
<td>DP master</td>
<td>-</td>
</tr>
<tr>
<td>DP slave</td>
<td>-</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
<tr>
<td>5V DC Power supply</td>
<td>max. 90mA, non-isolated</td>
</tr>
<tr>
<td><strong>Order no.</strong></td>
<td><strong>214-2BM03</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>24V DC Power supply</td>
<td>max. 100mA, non-isolated</td>
</tr>
</tbody>
</table>

- **Type**: DP
- **Type of interface**: RS485
- **Connector**: Sub-D, 9-pin, female
- **Electrically isolated**: ✓
- **MPI**: -
- **MPI² (MPI/RS232)**: -
- **DP master**: yes
- **DP slave**: -
- **Point-to-point interface**: -
- **5V DC Power supply**: max. 90mA, isolated
- **24V DC Power supply**: -

**Functionality MPI**

- **Number of connections, max.**: 16
- **PG/OP channel**: ✓
- **Routing**: -
- **Global data communication**: ✓
- **S7 basic communication**: ✓
- **S7 communication**: ✓
- **S7 communication as server**: ✓
- **S7 communication as client**: -
- **Transmission speed, min.**: 19.2 kbit/s
- **Transmission speed, max.**: 187.5 kbit/s

**Functionality PROFINET master**

- **PG/OP channel**: ✓
- **Routing**: -
- **S7 basic communication**: -
- **S7 communication**: -
- **S7 communication as server**: -
- **S7 communication as client**: -
- **Activation/deactivation of DP slaves**: ✓
- **Direct data exchange (slave-to-slave communication)**: -
- **DPV1**: -
- **Transmission speed, min.**: 9.6 kbit/s
- **Transmission speed, max.**: 12 Mbit/s
- **Number of DP slaves, max.**: 64
- **Address range inputs, max.**: 1 KB
- **Address range outputs, max.**: 1 KB
- **User data inputs per slave, max.**: 244 Byte
- **User data outputs per slave, max.**: 244 Byte

**Datatypes**

- **Input bytes**: 0
- **Output bytes**: 0
- **Parameter bytes**: 4
- **Diagnostic bytes**: 0

**Housing**

| Material | PPE / PA 6.6 |
| Mounting | Profile rail 35 mm |

**Mechanical data**

| Dimensions (WxHxD) | 50.8 x 76 x 80 mm |
| Weight | 150 g |

**Environmental conditions**

- **Operating temperature**: 0 °C to 60 °C
- **Storage temperature**: -25 °C to 70 °C

**Certifications**

- **UL certification**: yes
## Chapter 2 Hardware description

### Manual VIPA System 200V

#### 215-2BM03

<table>
<thead>
<tr>
<th>Order no.</th>
<th>215-2BM03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 215DPM</td>
</tr>
</tbody>
</table>

#### Technical data: power supply

- **Power supply (rated value):** DC 24 V
- **Power supply (permitted range):** DC 20.4...28.8 V
- **Reverse polarity protection:** ✓
- **Current consumption (no-load operation):** 130 mA
- **Inrush current:** 65 A
- **I²t:** 0.75 A²s
- **Max. current drain at backplane bus:** 3 A
- **Power loss:** 5 W

#### Load and working memory

- **Load memory, integrated:** 192 KB
- **Load memory, maximum:** 192 KB
- **Work memory, integrated:** 128 KB
- **Work memory, maximal:** 128 KB
- **Memory divided in 50% program / 50% data:** -
- **Memory card slot:** MMC-Card with max. 512 MB

#### Hardware configuration

- **Racks, max.:** 4
- **Modules per rack, max.:** total max. 32
- **Number of integrated DP master:** 1
- **Number of DP master via CP:** 8
- **Operable function modules:** 32
- **Operable communication modules PtP:** 32
- **Operable communication modules LAN:** -

#### Command processing times

- **Bit instructions, min.:** 0.18 µs
- **Word instruction, min.:** 0.78 µs
- **Double integer arithmetic, min.:** 1.8 µs
- **Floating-point arithmetic, min.:** 40 µs

#### Timers/Counters and their retentive characteristics

- **Number of S7 counters:** 256
- **S7 counter remanence adjustable:** 0 up to 64
- **S7 counter remanence adjustable C0 .. C7:**
- **Number of S7 times:** 256
- **S7 times remanence adjustable:** 0 up to 128
- **S7 times remanence adjustable not retentive:**

#### Data range and retentive characteristic

- **Number of flags:** 8192 Bit
- **Bit memories retentive characteristic adjustable:** adjustable 0 up to 256
- **Bit memories retentive characteristic preset MB0 .. MB15:**
- **Number of data blocks:** 2047
- **Max. data blocks size:** 16 KB
- **Number range DBs:** 1 ... 2047
- **Max. local data size per execution level:** 1024 Byte
- **Max. local data size per block:** 1024 Byte

#### Blocks

- **Number of OBs:** 14
- **Maximum OB size:** 16 KB
- **Total number DBs, FBs, FCs:** -
- **Number of FBs:** 1024
- **Maximum FB size:** 16 KB
- **Number range FBs:** 0 ... 1023
- **Number of FCs:** 1024
- **Maximum FC size:** 16 KB
- **Number range FCs:** 0 ... 1023
- **Maximum nesting depth per priority class:** 8
- **Maximum nesting depth additional within an error OB:** 1
<table>
<thead>
<tr>
<th>Order no.</th>
<th>215-2BM03</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time</strong></td>
<td></td>
</tr>
<tr>
<td>Real-time clock buffered</td>
<td>✓</td>
</tr>
<tr>
<td>Clock buffered period (min.)</td>
<td>30 d</td>
</tr>
<tr>
<td>Type of buffering</td>
<td>Vanadium Rechargeable Lithium Batterie</td>
</tr>
<tr>
<td>Load time for 50% buffering period</td>
<td>20 h</td>
</tr>
<tr>
<td>Load time for 100% buffering period</td>
<td>48 h</td>
</tr>
<tr>
<td>Accuracy (max. deviation per day)</td>
<td>10 s</td>
</tr>
<tr>
<td>Number of operating hours counter</td>
<td>8</td>
</tr>
<tr>
<td>Clock synchronization</td>
<td>-</td>
</tr>
<tr>
<td>Synchronization via MPI</td>
<td>-</td>
</tr>
<tr>
<td>Synchronization via Ethernet (NTP)</td>
<td>-</td>
</tr>
<tr>
<td><strong>Address areas (I/O)</strong></td>
<td></td>
</tr>
<tr>
<td>Input I/O address area</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Output I/O address area</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Process image adjustable</td>
<td>-</td>
</tr>
<tr>
<td>Input process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Output process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Input process image maximal</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Output process image maximal</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8192</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8192</td>
</tr>
<tr>
<td>Digital inputs central</td>
<td>512</td>
</tr>
<tr>
<td>Digital outputs central</td>
<td>512</td>
</tr>
<tr>
<td>Integrated digital inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated digital outputs</td>
<td>-</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog inputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Analog outputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Integrated analog inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated analog outputs</td>
<td>-</td>
</tr>
<tr>
<td><strong>Communication functions</strong></td>
<td></td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>Number of GD circuits, max.</td>
<td>4</td>
</tr>
<tr>
<td>Size of GD packets, max.</td>
<td>22 Byte</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication, user data per job</td>
<td>76 Byte</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication, user data per job</td>
<td>160 Byte</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>16</td>
</tr>
<tr>
<td><strong>Functionality Sub-D interfaces</strong></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>MPI</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>-</td>
</tr>
<tr>
<td>MPI</td>
<td>✓</td>
</tr>
<tr>
<td>MPI (MPI/RS232)</td>
<td>✓</td>
</tr>
<tr>
<td>DP master</td>
<td>-</td>
</tr>
<tr>
<td>DP slave</td>
<td>-</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
<tr>
<td>5V DC Power supply</td>
<td>max. 90mA, non-isolated</td>
</tr>
<tr>
<td>24V DC Power supply</td>
<td>max. 100mA, non-isolated</td>
</tr>
<tr>
<td>Type</td>
<td>DP</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Order no.</td>
<td>215-2BM03</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>MPI</td>
<td></td>
</tr>
<tr>
<td>MPI² (MPI/RS232)</td>
<td>-</td>
</tr>
<tr>
<td>DP master</td>
<td>yes</td>
</tr>
<tr>
<td>DP slave</td>
<td>-</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
<tr>
<td>5V DC Power supply</td>
<td>max. 90mA, isolated</td>
</tr>
<tr>
<td>24V DC Power supply</td>
<td></td>
</tr>
</tbody>
</table>

**Functionality MPI**

| Number of connections, max. | 16         |
| Routing                      | ✓         |
| Global data communication    | ✓         |
| S7 basic communication       | ✓         |
| S7 communication             | ✓         |
| S7 communication as server   | ✓         |
| S7 communication as client   | -         |
| Transmission speed, min.     | 19.2 kbit/s |
| Transmission speed, max.     | 187.5 kbit/s |

**Functionality PROFIBUS master**

| PG/OP channel               | ✓         |
| Routing                      | -         |
| S7 basic communication       | -         |
| S7 communication             | -         |
| S7 communication as server   | -         |
| S7 communication as client   | -         |
| Activation/deactivation of DP slaves | ✓     |
| Direct data exchange (slave-to-slave communication) | -      |
| DPV1                         | -         |
| Transmission speed, min.     | 9.6 kbit/s |
| Transmission speed, max.     | 12 Mbit/s |
| Number of DP slaves, max.    | 64        |
| Address range inputs, max.   | 1 KB      |
| Address range outputs, max.  | 1 KB      |
| User data inputs per slave, max. | 244 Byte |
| User data outputs per slave, max. | 244 Byte |

**Datasizes**

| Input bytes | 0 |
| Output bytes | 0 |
| Parameter bytes | 4 |
| Diagnostic bytes | 0 |

**Housing**

| Material | PPE / PA 6.6 |
| Mounting | Profile rail 35 mm |

**Mechanical data**

| Dimensions (WxHxD) | 50.8 x 76 x 80 mm |
| Weight             | 150 g             |

**Environmental conditions**

| Operating temperature | 0 °C to 60 °C |
| Storage temperature   | -25 °C to 70 °C |

**Certifications**

| UL certification | yes |
Chapter 3  Deployment CPU 21x-2BM03

Overview
This chapter describes the deployment of the CPU in the System 200V. The description refers directly to the CPU and to the deployment in connection with peripheral modules, mounted on a profile rail together with the CPU at the backplane bus.

<table>
<thead>
<tr>
<th>Content</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 3</td>
<td>Deployment CPU 21x-2BM03</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>Assembly</td>
<td>3-2</td>
</tr>
<tr>
<td></td>
<td>Start-up behavior</td>
<td>3-2</td>
</tr>
<tr>
<td></td>
<td>Addressing</td>
<td>3-3</td>
</tr>
<tr>
<td></td>
<td>Hints for the deployment of the MPI interface</td>
<td>3-5</td>
</tr>
<tr>
<td></td>
<td>Hardware configuration - CPU</td>
<td>3-6</td>
</tr>
<tr>
<td></td>
<td>Hardware configuration - I/O modules</td>
<td>3-8</td>
</tr>
<tr>
<td></td>
<td>Setting CPU parameters</td>
<td>3-9</td>
</tr>
<tr>
<td></td>
<td>Project transfer</td>
<td>3-13</td>
</tr>
<tr>
<td></td>
<td>Operating modes</td>
<td>3-17</td>
</tr>
<tr>
<td></td>
<td>Overall reset</td>
<td>3-19</td>
</tr>
<tr>
<td></td>
<td>Firmware update</td>
<td>3-21</td>
</tr>
<tr>
<td></td>
<td>Factory reset</td>
<td>3-23</td>
</tr>
<tr>
<td></td>
<td>VIPA specific diagnostic entries</td>
<td>3-24</td>
</tr>
<tr>
<td></td>
<td>Using test functions for control and monitoring of variables</td>
<td>3-26</td>
</tr>
</tbody>
</table>
Assembly

Note!
Information about assembly and cabling may be found at chapter “Basics and Assembly”.

Start-up behavior

Turn on power supply
When the CPU is delivered it has been reset. After the power supply has been switched on, the CPU changes to the operating mode the operating mode lever shows. After a STOP→RUN transition the CPU switches to RUN without program.

Note!
Due to a long storage of the CPU, the battery may be discharged excessively. Please connect the CPU at least for 24 hours to the power supply, to achieve the full buffer capacity.

Boot procedure with valid data in the CPU
The CPU switches to RUN with the program stored in the battery buffered RAM.

Boot procedure with empty battery
The accumulator/battery is automatically loaded via the integrated power supply and guarantees a buffer for max. 30 days. If this time is exceeded, the battery may be totally discharged. This means that the battery buffered RAM is deleted.

In this state, the CPU executes an overall reset because with an empty battery the RAM content is undefined. If a MMC with a S7PROG.WLD is plugged, program code and data blocks are transferred from the MMC into the work memory of the CPU.

If there is no MMC, the project from the internal Flash is loaded.

Depending on the position of the operating mode switch, the CPU remains in STOP respectively switches to RUN. Due to the battery error the CPU can only boot if there was an OB81 configured. Otherwise a manual restart (STOP/RUN) respectively PG command is necessary.

On a start-up with an empty battery the SF LED is on and thus points to an entry in the diagnostic buffer. Information about the Event-IDs can be found at “VIPA specific diagnostic entries”.

Attention!
After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset.
Addressing

Automatic addressing

To provide specific addressing of the installed peripheral modules, certain addresses must be allocated in the CPU.
The CPU contains a peripheral area (addresses 0 ... 1023) and a process image of the inputs and the outputs (for both each address 0 ... 127).
When the CPU is initialized it automatically assigns peripheral addresses to the digital input/output modules starting from 0.
If there is no hardware projecting, analog modules are allocated to even addresses starting from address 128.

Signaling states in the process image

The signaling states of the lower addresses (0 ... 127) are additionally saved in a special memory area called the *process image*.
The process image is divided into two parts:
- process image of the inputs (PII)
- process image of the outputs (PIQ)

The process image is updated automatically when a cycle has been completed.

Read/write access

You may access the modules by means of read or write operations on the peripheral bytes or on the process image.

Note!

Please remember that you may access different modules by means of read and write operations on the same address.
The addressing ranges of digital and analog modules are different when they are addressed automatically.
Digital modules: 0 ... 127
Analog modules: 128 ... 1023
Example for automatic address allocation

The following figure illustrates the automatic allocation of addresses:

![Allocation Diagram]

Modifying allocated addresses by configuration

You may change the allocated addresses at any time by means of the Siemens SIMATIC manager. In this way you may also change the addresses of analog modules to the range covered by the process image (0 ... 127) and address digital modules above 127.

The following pages describe the required preparations and the procedure for this type of configuration.
Hints for the deployment of the MPI interface

What is MP²I?

The MP²I jack combines 2 interfaces in 1:
- MP interface
- RS232 interface

Please regard that the RS232 functionality is only available by using the Green Cable from VIPA.

Deployment as MP interface

The MP interface provides the data transfer between CPUs and PCs. In a bus communication you may transfer programs and data between the CPUs interconnected via MPI.
Connecting a common MPI cable, the MPI jack supports the full MPI functionality.

Important notes for the deployment of MPI cables!

Deploying MPI cables at the CPUs from VIPA, you have to make sure that Pin 1 is not connected. This may cause transfer problems and in some cases damage the CPU!
Especially PROFIBUS cables from Siemens, like e.g. the 6XV1 830-1CH30, must not be deployed at MP²I jack.
For damages caused by nonobservance of these notes and at improper deployment, VIPA does not take liability!

Deployment as RS232 interface only via "Green Cable"

For the serial data transfer from your PC, you normally need a MPI transducer. Fortunately you may also use the "Green Cable" from VIPA. You can order this under the order no. VIPA 950-0KB00.

The "Green Cable" supports a serial point-to-point connection for data transfer via the MP²I jack exclusively for VIPA CPUs.
Hardware configuration - CPU

Overview

For the project engineering of the CPU 21x and the other System 200V modules connected to the same VIPA bus, the hardware configurator from Siemens is to be used.

To address the directly plugged peripheral modules, you have to assign a special address in the CPU to every module.

The address allocation and the parameterization of the modules takes place in the Siemens SIMATIC manager as a virtual PROFIBUS system. For the PROFIBUS interface is standardized software sided, the functionality is guaranteed by including a GSD-file into the Siemens SIMATIC manager.

Transfer your project into the CPU via the MPI interface.

Requirements

The following conditions must be fulfilled for project engineering:

- The Siemens SIMATIC manager is installed at PC respectively PU
- The GSD files have been included in Siemens hardware configurator
- Serial connection to the CPU (e.g. MPI-Adapter)

Note!

The configuration of the CPU requires a thorough knowledge of the Siemens SIMATIC manager and the hardware configurator!

Including the GSD-file

- Go to www.vipa.com > Service > Download > PROFIBUS GSD files and download the file System_100V_-_200V_Vxxx.zip.
- Extract the file to your work directory. The vipa_21x.gsd (German) respectively vipa_21x.gse (English) can be found at the directory CPU21x.
- Start the Siemens hardware configurator and close every project.
- Go to Options > Install new GSD file
- Navigate to the directory CPU21x and choose the corresponding file vipa_21x.gsd (German) or vipa_21x.gse (English)

Now the modules of the VIPA System 200V are integrated in the hardware catalog at PROFIBUS-DP \ Additional field devices \ I/O \ VIPA_System_200V.
To be compatible with the Siemens SIMATIC manager the following steps should be executed:

- Start the hardware configurator from Siemens with a new project.
- Insert a profile rail from the hardware catalog.
- Place at slot 2 the following CPU from Siemens:
  **CPU 315-2DP (315-2AF03 0AB00 V1.2)**
- For the System 200V create a new PROFIBUS subnet.
- Attach the slave system "VIPA_CPU21x" to the subnet with PROFIBUS-Address 1.
  After installing the vipa_21x.gsd the slave system may be found at the hardware catalog at PROFIBUS DP > Additional field devices > IO > VIPA_System_200V.
- Place **always at the 1. slot** the corresponding CPU 21x-2BM03, by taking it from the hardware catalog.
Hardware configuration - I/O modules

Hardware configuration of the modules

After the hardware configuration of the CPU place the System 200V modules in the plugged sequence.

In order to address the installed peripheral modules individually, specific addresses in the CPU have to be assigned to them.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CPU 315-2DP</td>
</tr>
<tr>
<td>2</td>
<td>DP</td>
</tr>
<tr>
<td>3</td>
<td>PROFIBUS (1): DP master system (1)</td>
</tr>
</tbody>
</table>

PB-Addr.:1
PB-Addr.:2

Parameter DIO

Parameter DIO

For parameterization double-click during the project engineering at the slot overview on the module you want to parameterize. In the appearing dialog window you may set the wanted parameters.

Parameterization during runtime

By using the SFCs 55, 56 and 57 you may alter and transfer parameters for wanted modules during runtime.

For this you have to store the module specific parameters in so called "record sets".

More detailed information about the structure of the record sets is to find in the according module description.
Setting CPU parameters

Parameterization via Siemens CPU 315-2AF03

Since the CPU from VIPA is to be configured as Siemens CPU 315-2DP (315-2AF03 0AB00 V1.2) in the Siemens hardware configurator, the parameters of the VIPA CPU may be set with "Object properties" of the CPU 315-2DP during hardware configuration.

Via a double-click on the CPU 315-2DP the parameter window of the CPU may be accessed.
Using the registers you get access to every standard parameter of the CPU.

The CPU does not evaluate each parameter, which may be set at the hardware configuration.

The following parameters are supported by the CPU at this time:

General

Short description
The short description of the Siemens CPU 315-2AF03 is CPU 315-2DP.

Order No. / Firmware
Order number and firmware are identical to the details in the "hardware catalog" window.

Name
The Name field provides the short description of the CPU. If you change the name the new name appears in the Siemens SIMATIC manager.

Comment
In this field information about the module may be entered.

Startup

Startup when expected/actual configuration differs
If the checkbox for "Startup when expected/actual configuration differ" is deselected and at least one module is not located at its configured slot or if another type of module is inserted there instead, then the CPU does not switch to RUN mode and remains in STOP mode.
If the checkbox for "Startup when expected/actual configuration differ" is selected, then the CPU starts even if there are modules not located in their configured slots of if another type of module is inserted there instead, such as during an initial system start-up.
This operation specifies the maximum time for the ready message of every configured module after PowerON. Here connected PROFIBUS DP slaves are also considered until they are parameterized. If the modules do not send a ready message to the CPU by the time the monitoring time has expired, the actual configuration becomes unequal to the preset configuration.

The maximum time for the transfer of parameters to parameterizable modules. If not every module has been assigned parameters by the time this monitoring time has expired; the actual configuration becomes unequal to the preset configuration.

This parameter is not relevant.

Here the scan cycle monitoring time in milliseconds may be set. If the scan cycle time exceeds the scan cycle monitoring time, the CPU enters the STOP mode. Possible reasons for exceeding the time are:

- Communication processes
- a series of interrupt events
- an error in the CPU program

This parameter is not relevant.

Using this parameter you can control the duration of communication processes, which always extend the scan cycle time so it does not exceed a specified length.

If the cycle load from communication is set to 50%, the scan cycle time of OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still being influenced by asynchronous events (e.g. hardware interrupts) as well.

The preset reaction of the CPU may be changed to an I/O access error that occurs during the update of the process image by the system.

The VIPA CPU is preset such that OB 85 is not called if an I/O access error occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the number of the memory byte.

Note!
The selected memory byte cannot be used for temporary data storage.
Retentive Memory

Number of Memory Bytes from MB0
Enter the number of retentive memory bytes from memory byte 0 onwards.

Number of S7 Timers from T0
Enter the number of retentive S7 timers from T0 onwards. Each S7 timer occupies 2 bytes.

Number of S7 Counters from C0
Enter the number of retentive S7 counter from C0 onwards.

Areas
These parameters are not relevant.

Interrupts

Priority
Here the priorities are displayed, according to which the hardware interrupt OBs are processed (hardware interrupt, time-delay interrupt, async. error interrupts).

Time-of-day interrupts

Priority
Here the priorities may be specified according to which the time-of-day interrupt is processed. With priority "0" the corresponding OB is deactivated.

Active
Activate the check box of the time-of-day interrupt OBs if these are to be automatically started on complete restart.

Execution
Select how often the interrupts are to be triggered. Intervals ranging from every minute to yearly are available. The intervals apply to the settings made for start date and time.

Start date / time
Enter date and time of the first execution of the time-of-day interrupt.

Process image partition
This parameter is not supported.

Cyclic interrupts

Priority
Here the priorities may be specified according to which the corresponding cyclic interrupt is processed. With priority "0" the corresponding interrupt is deactivated.
Execution

Enter the time intervals in ms, in which the watchdog interrupt OBs should be processed. The start time for the clock is when the operating mode switch is moved from STOP to RUN.

Phase offset

Enter the delay time in ms for current execution for the watch dog interrupt. This should be performed if several watchdog interrupts are enabled. Phase offset allows to distribute processing time for watchdog interrupts across the cycle.

Process image partition

This parameter is not supported.

Protection

Level of protection

Here 1 of 3 protection levels may be set to protect the CPU from unauthorized access.

Protection level 1 (default setting):
- No password adjustable, no restrictions

Protection level 2 with password:
- Authorized users: read and write access
- Unauthorized user: read access only

Protection level 3:
- Authorized users: read and write access
- Unauthorized user: no read and write access
Project transfer

Overview
There are the following possibilities for project transfer into the CPU:

- Transfer via MPI
- Transfer via MMC when using a MMC programmer

Transfer via MPI
The structure of a MPI net is electrically identical with the structure of a PROFIBUS net. This means the same rules are valid and you use the same components for the build-up. The single participants are connected with each other via bus interface plugs and PROFIBUS cables. Per default the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI address 2.

MPI programming cable
The MPI programming cables are available at VIPA in different variants. The cables provide a RS232 res. USB plug for the PC and a bus enabled RS485 plug for the CPU.

Due to the RS485 connection you may plug the MPI programming cables directly to an already plugged plug on the RS485 jack. Every bus participant identifies itself at the bus with an unique address, in the course of the address 0 is reserved for programming devices.

Terminating resistor
A cable has to be terminated with its surge impedance. For this you switch on the terminating resistor at the first and the last participant of a network or a segment.

Please make sure that the participants with the activated terminating resistors are always power supplied. Otherwise it may cause interferences on the bus.

Transfer with MPI programming cable (MPI communication)

Transfer via Green Cable (serial communication)
Via exclusively direct plugging of the Green Cable to a MP²I jack you may establish a serial connection between PC and CPU. Set the PC-COM port and the transfer rate 38400Baud at Local port. The settings of the register MPI are ignored at employment of the Green Cable.
Hints for configuring a MPI interface are to find in the documentation of your programming software.
The "Green Cable" has the order number VIPA 950-0KB00.

Attention!
Please regard, that you may use the "Green Cable" exclusively at VIPA CPUs with MP2I-interface!
Please regard the hints for deploying the Green Cable and the MP2I jack!

Approach transfer via MPI interface

- Connect your PC to the MPI jack of your CPU via a MPI programming cable.
- Load your project in the SIMATIC manager from Siemens.
- Choose in the menu Options > Set PG/PC interface
- Select in the according list the "PC Adapter (MPI)"; if appropriate you have to add it first, then click on [Properties].
- Set in the register MPI the transfer parameters of your MPI net and type a valid address.
- Switch to the register Local connection
- Set the COM port of the PC and the transfer rate 38400Baud for the MPI programming cable from VIPA.
- Via PLC > Load to module you may transfer your project via MPI to the CPU and save it on a MMC via PLC > Copy RAM to ROM if one is plugged.

Note!
Please make sure to adjust the transfer rate to 38400Baud when using the "Green Cable" from VIPA.
Hints for the Green Cable

The Green Cable is a green connection cable, manufactured exclusively for the deployment at VIPA System components. The Green Cable is a programming and download cable for VIPA CPUs MP2I jack and VIPA field bus masters. The Green Cable from VIPA is available under the order no. VIPA 950-0KB00.

The Green Cable allows you to:

- **transfer projects serial**
  Avoiding high hardware needs (MPI transducer, etc.) you may realize a serial point-to-point connection via the Green Cable and the MP2I jack. This allows you to connect components to your VIPA-CPU that are able to communicate serial via a MPI adapter like e.g. a visualization system.

- **execute firmware updates of the CPUs and field bus masters**
  Via the Green Cable and an upload application you may update the firmware of all recent VIPA CPUs with MP2I jack and certain field bus masters (see Note).

Important notes for the deployment of the Green Cable

Nonobservance of the following notes may cause damages on system components.

For damages caused by nonobservance of the following notes and at improper deployment, VIPA does not take liability!

Note to the application area

The Green Cable may exclusively deployed directly at the concerning jacks of the VIPA components (in between plugs are not permitted). E.g. a MPI cable has to be disconnected if you want to connect a Green Cable.

At this time, the following components support Green Cable:

- VIPA CPUs with MP2I jack and field bus masters from VIPA.

Note to the lengthening

The lengthening of the Green Cable with another Green Cable res. The combination with further MPI cables is not permitted and causes damages of the connected components!

The Green Cable may only be lengthened with a 1:1 cable (all 9 pins are connected 1:1).
Transfer via MMC

The MMC (Memory Card) serves as external transfer and storage medium. There may be stored several projects and sub-directories on a MMC storage module. Please regard that your current project is stored in the root directory and has one of the following file names:

- S7PROG.WLD
- S7PROGF.WLD
- AUTOLOAD.WLD

With File > Memory Card File > New in the Siemens SIMATIC manager a new wld file may be created. After the creation copy the blocks from the project blocks folder and the System data into the wld file.

Transfer MMC → CPU

The transfer of the application program from the MMC into the CPU takes place depending on the file name after an overall reset or PowerON.

- S7PROG.WLD is read from the MMC after overall reset and transferred into the battery buffered RAM.
- S7PROGF.WLD is read from the MMC after overall reset and transferred into the battery buffered RAM and additionally into the Flash memory. An access to the Flash memory only takes place at empty battery of the buffer and when no MMC with user program is plugged-in.
- AUTOLOAD.WLD is read after PowerON from the MMC and transferred into the battery-buffered RAM.

During the transfer the "MC" LED blinks. Please regard that your user memory serves for enough space, otherwise your user program is not completely loaded and the SF LED gets on. Execute a compression before the transfer, for this does not happen automatically.

Transfer CPU → MMC

When the MMC has been installed, the write command stores the content of the battery buffered RAM as S7PROG.WLD on the MMC and in the internal Flash memory.

The write command is controlled by means of the block area of the Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write process the "MC"-LED of the CPU is blinking. When the LED expires the write process is finished.

If this project is to be loaded automatically from the MMC with PowerON, you have to rename this on the MMC to AUTOLOAD.WLD.

Transfer control

After a MMC access, an ID is written into the diagnostic buffer of the CPU.

To monitor the diagnosis entries, you select PLC > Module Information in the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you reach the diagnosis window.

Information about the Event-IDs can be found at "VIPA specific diagnostic entries".
Operating modes

Overview

The CPU can be in one of 3 operating modes:

- Operating mode STOP
- Operating mode START-UP
- Operating mode RUN

Certain conditions in the operating modes START-UP and RUN require a specific reaction from the system program. In this case the application interface is often provided by a call to an organization block that was included specifically for this event.

Operating mode STOP

- The application program is not processed.
- If there has been a processing before, the values of counters, timers, flags and the process image are retained during the transition to the STOP mode.
- Outputs are inhibited, i.e. all digital outputs are disabled.
- RUN-LED (R) off
- STOP-LED (S) on

Operating mode START-UP

- During the transition from STOP to RUN the system calls the start-up organization block OB 100. The processing time for this OB is not monitored. The start-up OB may issue calls to other blocks.
- All digital outputs are disabled during the start-up, i.e. outputs are inhibited.
- RUN-LED blinks as soon as the OB 100 is operated and for at least 3s, even if the start-up time is shorter or the CPU gets to STOP due to an error. This indicates the start-up.
- STOP-LED off

When the CPU has completed the start-up OB, it assumes the operating mode RUN.

Operating mode RUN

- The application program in OB 1 is processed in a cycle. Under the control of alarms other program sections can be included in the cycle.
- All timers and counters being started by the program are active and the process image is updated with every cycle.
- The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs are enabled.
- RUN-LED on
- STOP-LED off
Function security  
The CPUs include security mechanisms like a watchdog (100ms) and a parameterizable cycle time surveillance (parameterizable min. 1ms) that stop res. execute a RESET at the CPU in case of an error and set it into a defined STOP state.

The VIPA CPUs are developed function secure and have the following system properties:

<table>
<thead>
<tr>
<th>Event</th>
<th>Concerns</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN (\rightarrow) STOP</td>
<td>general</td>
<td>BASP (Befehls-Ausgabe-Sperre, i.e. command output lock) is set.</td>
</tr>
<tr>
<td></td>
<td>central digital outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The Outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Voltage outputs issue 0V</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Current outputs 0...20mA issue 0mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Current outputs 4...20mA issue 4mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If configured also substitute values may be issued.</td>
</tr>
<tr>
<td></td>
<td>decentral outputs</td>
<td>Same behavior as the central digital/analog outputs.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are cyclically be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>STOP (\rightarrow) RUN res. PowerON</td>
<td>general</td>
<td>First the PII is deleted, then OB 100 is called. After the execution of the OB, the BASP is reset and the cycle starts with: Delete PIO (\rightarrow) Read PII (\rightarrow) OB 1.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The behavior of the outputs at restart can be preset.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are cyclically be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>RUN</td>
<td>general</td>
<td>The program execution happens cyclically and can therefore be foreseen: Read PII (\rightarrow) OB 1 (\rightarrow) Write PIO.</td>
</tr>
</tbody>
</table>

PII = Process image inputs
PIO = Process image outputs
Overall reset

Overview

During the overall reset the entire user memory is erased. Data located in the memory card is not affected.

You have 2 options to initiate an overall reset:

- initiate the overall reset by means of the function selector switch
- initiate the overall reset by means of the configuration software e.g. Siemens SIMATIC manager

Note!

You should always issue an overall reset to your CPU before loading an application program into your CPU to ensure that all blocks have been cleared from the CPU.

Overall reset by means of the function selector

Condition

The operating mode of the CPU is STOP. Place the function selector on the CPU in position "ST" → the S-LED is on.

Overall reset

- Place the function selector in the position MR and hold it in this position for app. 3 seconds. → The S-LED changes from blinking to permanently on.
- Place the function selector in the position ST and switch it to MR and quickly back to ST within a period of less than 3 seconds. → The S-LED blinks (overall reset procedure).
- The overall reset has been completed when the S-LED is on permanently. → The S-LED is on.

The following figure illustrates the above procedure:

![Overall reset procedure diagram]
Automatic reload

If there is a project S7PROG.WLD on the MMC, the CPU attempts to reload this project from MMC → the MC LED is on.

When the reload has been completed the LED is extinguished. The operating mode of the CPU will be STOP or RUN, depending on the position of the function selector.

Overall reset by means of the Siemens SIMATIC manager

Condition

The operating mode of the CPU must be STOP.

You may place the CPU in STOP mode by the menu command PLC > Operating mode.

Overall reset

You may request the overall reset by means of the menu command PLC > Clean/Reset.

In the dialog window you may place your CPU in STOP mode and start the overall reset if this has not been done as yet.

The S-LED blinks during the overall reset procedure.

When the S-LED is on permanently the overall reset procedure has been completed.

Automatic reload

At this point the CPU attempts to reload the parameters and the program from the memory card. → The MC LED is on.

When the reload has been completed, the LED expires. The operating mode of the CPU will be STOP or RUN, depending on the position of the function selector.

Reset to factory setting

A Factory reset deletes the internal RAM of the CPU completely and sets it back to the delivery state.

Please regard that the MPI address is also set back to default 2!

More information may be found at the part "Factory reset" further below.
Firmware update

Overview
There is the opportunity to execute a firmware update for the CPU and its components via MMC. For this an accordingly prepared MMC must be in the CPU during the startup.

So a firmware file can be recognized and assigned with startup, a file name is reserved for each updateable component (see table below).

After PowerON and CPU STOP the CPU checks if there is a firmware file on the MMC. If this firmware version is different to the existing firmware version, this is indicated by blinking of the LEDs and the firmware may be installed by an update request.

Latest Firmware at www.vipa.com
The latest firmware versions are to be found in the service area at www.vipa.com

Find out CPU firmware version
A label on the rear of the module indicates the firmware version.

You may display the current firmware version of your CPU via the Siemens SIMATIC manager. To display the firmware version, you go online with the CPU via your PG or PC and start the Siemens SIMATIC manager.

Via PLC > Module status, register "General", the current firmware version is evaluated and displayed.

Load firmware and transfer it to MMC with reserved file name
- Go to www.vipa.com
- Click on Service > Download > Firmware.
- Navigate to via System 200V > CPU to your CPU and download according to your hardware version the zip file to your PC.
- Open the zip file and copy the bin file to your MMC.
- Rename this accordingly

Reserved file names
By means of a reserved file name in the CPU 21x-2BM03 you may transfer a firmware per MMC:

<table>
<thead>
<tr>
<th>Component</th>
<th>File name order no. release_version.ZIP</th>
<th>New file name at MMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Bx000... .bin</td>
<td>firmware.bin</td>
</tr>
<tr>
<td>DPM</td>
<td>Bx000589.bin</td>
<td>dpm00.bin</td>
</tr>
</tbody>
</table>
Attention!

When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the CPU, for example if the voltage supply is interrupted during transfer or if the firmware file is defective. In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.

Transfer firmware from MMC into CPU

1. Switch the operating mode switch of your CPU in position ST. Turn off the voltage supply. Plug the MMC with the firmware files into the CPU. Please take care of the correct plug-in direction of the MMC. Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC shows that at least a differing firmware file was found on the MMC.

3. You start the transfer of the firmware as soon as you tip the operating mode switch lever downwards to MR within 10s and leave it in ST position.

4. During the update process, the LEDs SF and FC are alternately blinking and MC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PW, S, SF, FC and MC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether further current firmware versions are available at the MMC. If so, again the LEDs SF and FC flash after a short start-up period. Continue with point 3.

If the LEDs do not flash, the firmware update is ready.

Now a factory reset should be executed (see next page). After that the CPU is ready for duty.
Factory reset

**Proceeding**

With the following proceeding the internal RAM of the CPU is completely deleted and the CPU is reset to delivery state.

Please note that here also the MPI address is reset to the address 2!

1. Switch the CPU to STOP.
2. Push the operating mode switch down to position MR for 30s. Here the S LED flashes. After a few seconds the stop LED changes to static light. Now the S LED changes between static light and flashing. Starting here count the static light states of the S LED.
3. After the 6. static light release the operating mode switch and tip it downwards to MR. Now the RUN LED lights up once. This means that the RAM was deleted completely.
4. For the confirmation of the resetting procedure the LEDs PW and S are on.
5. Then you have to switch the power supply off and on.

The proceeding is shown in the following Illustration:

---

**Note!**

After the firmware update you always should execute a *Factory reset*. 
VIPA specific diagnostic entries

Entries in the diagnostic buffer

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC manager. Besides of the standard entries in the diagnostic buffer, the VIPA CPUs support some additional specific entries in form of event-IDs.

Monitoring the diagnostic entries

To monitor the diagnostic entries you choose the option PLC > Module Information in the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you reach the diagnostic window:

![Diagnostic Buffer Window](image)

The diagnosis is independent from the operating mode of the CPU. You may store a max. of 100 diagnostic entries in the CPU. The following page shows an overview of the VIPA specific Event-IDs.
## Overview of the Event-IDs

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xE003   | Error at access to I/O devices  
|          | Zinfo1: I/O address  
|          | Zinfo2: Slot |
| 0xE004   | Multiple parameterization of a I/O address  
|          | Zinfo1: I/O address  
|          | Zinfo2: Slot |
| 0xE005   | Internal error – Please contact the VIPA-Hotline! |
| 0xE006   | Internal error – Please contact the VIPA-Hotline! |
| 0xE007   | Configured in-/output bytes do not fit into I/O area |
| 0xE008   | Internal error – Please contact the VIPA-Hotline! |
| 0xE009   | Error at access to standard back plane bus |
| 0xE010   | Not defined module group at backplane bus recognized  
|          | Zinfo2: Slot  
|          | Zinfo3: Type ID |
| 0xE011   | Master project engineering at Slave-CPU not possible or wrong slave configuration |
| 0xE012   | Error at parameterization |
| 0xE013   | Error at shift register access to VBUS digital modules |
| 0xE014   | Error at Check_Sys |
| 0xE015   | Error at access to the master  
|          | Zinfo2: Slot of the master (32=page frame master) |
| 0xE016   | Maximum block size at master transfer exceeded  
|          | Zinfo1: I/O address  
|          | Zinfo2: Slot |
| 0xE017   | Error at access to integrated slave |
| 0xE018   | Error at mapping of the master I/O devices |
| 0xE019   | Error at standard back plane bus system recognition |
| 0xE01A   | Error at recognition of the operating mode (8 / 9 Bit) |
| 0xE0CC   | Communication error MPI / Serial |
| 0xE100   | MMC access error |
| 0xE101   | MMC error file system |
| 0xE102   | MMC error FAT |
| 0xE104   | MMC error at saving |
| 0xE200   | MMC writing finished (Copy Ram to Rom) |
| 0xE210   | MMC reading finished (reload after overall reset) |
| 0xE300   | Internal Flash writing ready (Copy RAM to ROM) |
| 0xE310   | Internal Flash reading finished (reload after battery failure) |
Using test functions for control and monitoring of variables

Overview
For troubleshooting purposes and to display the status of certain variables you can access certain test functions via the menu item Debug of the Siemens SIMATIC manager.

The status of the operands and the VKE can be displayed by means of the test function Debug > Monitor.

You can modify and/or display the status of variables by means of the test function PLC > Monitor/Modify Variables.

Debug > Monitor
This test function displays the current status and the VKE of the different operands while the program is being executed.
It is also possible to enter corrections to the program.

Note!
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump commands or by timer and process-related alarms. At the breakpoint the CPU stops collecting data for the status display and instead of the required data it only provides the PG with data containing the value 0.
For this reason, jumps or time and process alarms can result in the value displayed during program execution remaining at 0 for the items below:

- the result of the logical operation VKE
- Status / AKKU 1
- AKKU 2
- Condition byte
- absolute memory address SAZ. In this case SAZ is followed by a “?”.

The interruption of the processing of statuses does not change the execution of the program. It only shows that the data displayed is no longer.
This test function returns the condition of a selected operand (inputs, outputs, flags, data word, counters or timers) at the end of program-execution.

This information is obtained from the process image of the selected operands. During the "processing check" or in operating mode STOP the periphery is read directly from the inputs. Otherwise only the process image of the selected operands is displayed.

**Control of outputs**

It is possible to check the wiring and proper operation of output-modules. You can set outputs to any desired status with or without a control program. The process image is not modified but outputs are no longer inhibited.

**Control of variables**

The following variables may be modified:
I, Q, M, T, C and D.

The process image of binary and digital operands is modified independently of the operating mode of the CPU.

When the operating mode is RUN the program is executed with the modified process variable. When the program continues they may, however, be modified again without notification.

Process variables are controlled asynchronously to the execution sequence of the program.
Chapter 4  PROFIBUS communication

Overview
Content of this chapter is the deployment of the 21x-2BM03 with PROFIBUS. After a short introduction into the PROFIBUS system, the project engineering and the usage with PROFIBUS is shown. This chapter ends with information about commissioning and start-up behavior of the DP master.

Content

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4  PROFIBUS communication</td>
<td>4-1</td>
</tr>
<tr>
<td>Overview</td>
<td>4-2</td>
</tr>
<tr>
<td>Project engineering CPU with integrated PROFIBUS DP master</td>
<td>4-5</td>
</tr>
<tr>
<td>PROFIBUS installation guidelines</td>
<td>4-7</td>
</tr>
<tr>
<td>Commissioning and Start-up behavior</td>
<td>4-10</td>
</tr>
</tbody>
</table>
Overview

PROFIBUS DP

PROFIBUS is an international standard applicable to an open and serial field bus for building, manufacturing and process automation that can be used to create a low (sensor-/actuator level) or medium (process level) performance network of programmable logic controllers.

PROFIBUS comprises an assortment of compatible versions. The following details refer to PROFIBUS DP.

PROFIBUS DP is a special protocol intended mainly for automation tasks in a manufacturing environment. DP is very fast, offers Plug'n'Play facilities and provides a cost-effective alternative to parallel cabling between PLC and remote I/O. PROFIBUS DP was designed for high-speed data communication on the sensor-actuator level.

The data transfer referred to as "Data Exchange" is cyclical. During one bus cycle, the master reads input values from the slaves and writes output information to the slave.

Master and slaves

PROFIBUS distinguishes between active stations (masters) and passive stations (slaves).

Master equipment

Master equipment controls the data traffic on the bus. There may be also several masters at one PROFIBUS. This is referred to as multi master operation. The bus protocol establishes a logical token ring between the intelligent devices connected to the bus.

A master of the CPU 21xDPM may send unsolicited messages if it has the bus access permission (Token). In the PROFIBUS protocol masters are also referred to as active stations.

Slave equipment

Typical slave equipment holds data of peripheral equipment, sensors, actuators or transducers. The VIPA PROFIBUS are modular slave equipment, transferring data between the System 200V periphery and the leading master.

These devices do not have bus access permission in accordance with the PROFIBUS standard. They may only acknowledge messages or transfer messages to a master if requested by this. Slaves occupy a very limited part of the bus protocol. Slaves are also referred to as passive stations.
Communication

The bus communication protocol provides two procedures for accessing the bus:

Master to Master

Communications with the master is also referred to as token passing procedure. Token passing guarantees that the station receives access permission to the bus. This access right to the bus is passed between the stations in form of a "token". A token is a specific message that is transferred via the bus.

When a master possesses the token, it has the access right to the bus and is allowed to communicate with all other active and passive stations. The token retention time is defined when the system is being configured. When the token retention time has expired, the token is passed along to the next master that acquires the bus access rights with the token so that this may now communicate with all other stations.

Master slave procedure

Data is exchanged in a fixed repetitive sequence between the master and the slaves assigned to this respective master. When you configure the system, you define which slaves are assigned to a certain master. You may also specify which DP slave is included in the cyclic exchange of application data and which ones are excluded.

The master slave data transfer is divided into parameterization, configuration and data transfer phases. Before a DP slave is included into the data transfer phase, the master verifies during the parameterization and configuration phase whether the specified configuration agrees with the effective configuration. This verification process checks the device type, format and length as well as the number of inputs and outputs. This provides you with effective protection against configuration errors.

The master handles application data transfers independently. In addition you may also send new configuration data to a bus coupler.

If in the status DE „Data Exchange“, the master is sending new basic data to the slave and the receipt of the slave transfers the recent input data to the master.

Data consistency

Data is referred to as being consistent, if it has the same logical contents. Data that belongs together is: the high- and low-byte of an analog value (word consistency) and the control and the status byte with the respective parameter word, required to access the registers.

The data consistency during the interaction between the peripherals and the controller is only guaranteed for 1Byte. That is, the bits of one byte are acquired together and they are transmitted together. Byte-wise consistency is sufficient for the processing of digital signals.
As transfer medium PROFIBUS uses an isolated drilled 2 core line based upon the RS485 interface or a duplex optical waveguide (OWG). The transfer rate is for both methods max. 12Mbaud.

The RS485 interface is working with voltage differences. Though it is less irritable from failures than a voltage or a current interface. You are able to configure the network as well linear as in a tree structure. Your VIPA PROFIBUS coupler includes a 9pin slot where you link up the PROFIBUS coupler into the PROFIBUS network as a slave.

The bus structure under RS485 allows an easy connection resp. disconnection of stations as well as starting the system step by step. Later expansions don’t have any influence on stations that are already integrated. The system realizes automatically if one partner had a fail down or if it is new in the network.

The optical waveguide system uses monochromatic light impulses. The optical waveguide is totally independent from disturbing voltage from other machines. An optical waveguide system is built up linear. Every module has to be connected with two links: one input link and one back. You don’t need to terminate the last module.

For the structure is a linear one, connecting and disconnecting stations is not free of consequences.

Every partner of the PROFIBUS network has to identify itself with a certain address. This address may be existing only one time in the bus system and has a value between 0 and 125.

At the CPU 21xDPM you choose the address via your software tool.

To configure the slave connections in your own configuration tool, you’ve got all the information about your VIPA modules in form of an electronic data sheet file (German: Geräteamndatei = GSD-file).

Structure and content of this file are dictated by the PROFIBUS User Organization (PNO) and may be seen there.

Install the GSD-file in your configuration tool. Look for more information in the online help of the according tool.
Project engineering CPU with integrated PROFIBUS DP master

Overview
For the project engineering of the PROFIBUS DP master you have to use the hardware manager from Siemens. Your PROFIBUS projects are transferred via MPI into the CPU 21x-2BM03 by means of the PLC functions. The CPU passes the data on to the PROFIBUS DP master.

Note!
For the project engineering of the CPU and the PROFIBUS DP master a thorough knowledge of the SIMATIC manager and the hardware configurator from Siemens is required!

Fast introduction
To be compatible to the Siemens SIMATIC manager, for the System 200V the following steps are necessary:

Master-System
- Configure the CPU 315-2DP with the DP master system (address 2).
- Add from the VIPA_21x.gsd the PROFIBUS slave “VIPA_CPU21x” with address 1.
- Insert the CPU 21x-2BM03 at the 1. slot of the slave system.
- Include the directly plugged peripheral modules at the sequencing slots.

Slave system
- Install the according GSD file for the slave system.
- Select from the hardware catalog the according slave system and drag it to the master system.
- Configure the according periphery modules of the slave system
- Transfer the project to the CPU 21x-2BM03.
Configuration of the master system

- Start the Siemens SIMATIC manager and configure a CPU as described at "Hardware configuration - CPU".
- Designate the station as "...DP master"
- Add your modules according to the real hardware assembly.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>CPU 21x-2BM03</td>
</tr>
<tr>
<td>1</td>
<td>Centralized Periph.</td>
</tr>
<tr>
<td>2</td>
<td>...</td>
</tr>
</tbody>
</table>

Configuration of the DP slaves

- Install the corresponding GSD file of your slave system in the hardware configurator.
- Search the corresponding PROFIBUS DP slave in the hardware catalog and drag&drop it to the subnet of your master.
- Assign a valid PROFIBUS address >3 to the DP slave
- Add your modules according to the real hardware assembly.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>CPU 21x-2BM03</td>
</tr>
<tr>
<td>1</td>
<td>Centralized Periph.</td>
</tr>
<tr>
<td>2</td>
<td>...</td>
</tr>
</tbody>
</table>

Transfer the project

- Transfer your project to the CPU 21x-2BM03.
PROFIBUS installation guidelines

**PROFIBUS in general**

- A PROFIBUS DP network may only be built up in linear structure.
- PROFIBUS DP consists of minimum one segment with at least one master and one slave.
- A master has always been deployed together with a CPU.
- PROFIBUS supports max. 126 participants.
- Per segment a max. of 32 participants is permitted.
- The max. segment length depends on the baud rate:
  
<table>
<thead>
<tr>
<th>Baud Rate</th>
<th>Segment Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.6 ... 187.5kbaud</td>
<td>1000m</td>
</tr>
<tr>
<td>500kbaud</td>
<td>400m</td>
</tr>
<tr>
<td>1.5Mbaud</td>
<td>200m</td>
</tr>
<tr>
<td>3 ... 12Mbaud</td>
<td>100m</td>
</tr>
</tbody>
</table>
- Max. 10 segments may be built up. The segments are connected via repeaters. Every repeater counts for one participant.
- The bus respectively a segment is to be terminated at both ends.
- All participants are communicating with the same baud rate. The slaves adjust themselves automatically on the baud rate.

**Transfer medium**

As transfer medium PROFIBUS uses an isolated twisted-pair cable based upon the RS485 interface.

The RS485 interface is working with voltage differences. Though it is less irritable from influences than a voltage or a current interface. You are able to configure the network as well linear as in a tree structure.

Max. 32 participants per segment are permitted. Within a segment the members are linear connected. The segments are connected via repeaters. The maximum segment length depends on the transfer rate.

PROFIBUS DP uses a transfer rate between 9.6kbaud and 12Mbaud, the slaves are following automatically. All participants are communicating with the same transfer rate.

The bus structure under RS485 allows an easy connection res. disconnection of stations as well as starting the system step by step. Later expansions don’t have any influence on stations that are already integrated. The system realizes automatically if one partner had a fail down or is new in the network.
Chapter 4  PROFIBUS communication

Bus connection

The following picture illustrates the terminating resistors of the respective start and end station.

Note!
The PROFIBUS line has to be terminated with its ripple resistor. Please make sure to terminate the last participants on the bus at both ends by activating the terminating resistor.

EasyConn
bus connector

In PROFIBUS all participants are wired parallel. For that purpose, the bus cable must be feed-through.

Via the order number VIPA 972-0DP10 you may order the bus connector "EasyConn". This is a bus connector with switchable terminating resistor and integrated bus diagnostic.

<table>
<thead>
<tr>
<th></th>
<th>0°</th>
<th>45°</th>
<th>90°</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>64</td>
<td>61</td>
<td>66</td>
</tr>
<tr>
<td>B</td>
<td>34</td>
<td>53</td>
<td>40</td>
</tr>
<tr>
<td>C</td>
<td>15.8</td>
<td>15.8</td>
<td>15.8</td>
</tr>
</tbody>
</table>

in mm
Note!
To connect this EasyConn plug, please use the standard PROFIBUS cable type A (EN50170). Starting with release 5 you also can use highly flexible bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322. With the order no. 905-6AA00 VIPA offers the “EasyStrip” de-isolating tool that makes the connection of the EasyConn much easier.

Dimensions in mm

Termination with "EasyConn"
The "EasyConn" bus connector is provided with a switch that is used to activate a terminating resistor.

Attention!
The terminating resistor is only effective, if the connector is installed at a bus participant and the bus participant is connected to a power supply.

Note!
A complete description of installation and deployment of the terminating resistors is delivered with the connector.

Assembly

- Loosen the screw.
- Lift contact-cover.
- Insert both wires into the ducts provided (watch for the correct line color as below!)
- Please take care not to cause a short circuit between screen and data lines!
- Close the contact cover.
- Tighten screw (max. tightening torque 4Nm).

Please note: The green line must be connected to A, the red line to B!
Commissioning and Start-up behavior

Start-up on delivery

In delivery the CPU is overall reset. The PROFIBUS part is deactivated and its LEDs are off after Power ON.

Online with bus parameter without slave project

The DP master can be served with bus parameters by means of a hardware configuration. As soon as these are transferred the DP master goes online with his bus parameter. This is shown by the RUN LED. Now the DP master can be contacted via PROFIBUS by means of his PROFIBUS address. In this state the CPU can be accessed via PROFIBUS to get configuration and DP slave project.

Slave configuration

If the master has received valid configuration data, he switches to Data Exchange with the DP Slaves. This is indicated by the DE-LED.

CPU state controls DP master

After PowerON respectively a receipt of a new hardware configuration the configuration data and bus parameter were transferred to the DP master. Dependent on the CPU state the following behavior is shown by the DP master:

Master behavior at CPU STOP

- The global control command "Clear" is sent to the slaves by the master. Here the DE-LED is blinking.
- DP slaves with fail safe mode were provided with output telegram length "0".
- DP slaves without fail safe mode were provided with the whole output telegram but with output data = 0.
- The input data of the DP slaves were further cyclically transferred to the input area of the CPU.

Master behavior at CPU RUN

- The global control command "Operate" is sent to the slaves by the master. Here the DE-LED is on.
- Every connected DP slave is cyclically attended with an output telegram containing recent output data.
- The input data of the DP slaves were cyclically transferred to the input area of the CPU.